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Architekt 



ENTWICKLUNG LEICHTBAU 



STRUKTUR UND AUSBAU 

 



Flexibel während der Planungs- und Bauzeit 

 

Individuelle Grundrissplanung 

 

Gewichtsersparnis  - positive Auswirkung auf die Statik 

 

PLANUNG 



geringe Baufeuchte 

beschleunigter Bauablauf  

 

 

geringeres Bauteilgewicht 

 

 

 

hohe Maßgenauigkeit 

 

 

 

sehr anpassungsfähig für Maßnahmen des Wärme-,  

Brand- und Schallschutzes 

 

 

 

gestalterische Vielfalt  

 

GEBÄUDEAUSBAU MIT TROCKENBAU 

 



Dachgeschoss- 
ausbau 

Nichttragende, innere 
Trennwand 

Vorsatzschalen,   
Installationswand  

halbhoch oder raumhoch 

Sonder- 
konstruktionen 

Deckenbekleidung, 

Deckenabhängung 

Trockenputz, 
Wandbekleidung 

TROCKENBAU 

Fertigteilestrich Systemböden 



STRUKTUR UND AUSBAU 

Schale              Raumkörper                   Scheibe 

Funktionswand             Raumkörper, Freie Form                Zellen, Wand 



Plattenarten/Plattenbaustoffe 

Anorganische Platten 

Zementgebunden 

Anorganische Platten 

Gipsgebunden 

Organische Platten 

 

Faserzementplatten 

Zementvliesplatten 

Silikatplatten 

Gipskartonplatten 

Gipsfaserplatten 

Gipsvliesplatten 

Holzfaserplatten  

Sperrholz  

Flachpressplatten 

Spanplatten 

Mineralplatten 

 

Kunststoffplatten 

 

Metallplatten 

 

Lehmplatten 

 

Glasplatten 

 

Hybridplatten.... 

BAUSTOFFE 

Massivholzplatten 



To change the style of your titles and text levels: 

1. Enter your text in the text box 

2. To move your text to the next level,  

on the Home menu, in the Paragraph group,  

click on Increase List Level 

 

3. To move your text to the previous level,  

on the Home menu, in the Paragraph group,  

click on Decrease List Level 

 

This will apply a predefined text style. 

To change the presentation title: 

1. On the Insert tab, go to Header & Footer 

2. Change the Presentation title in the Footer area 

3. Click on Apply to apply this change to the current 

slide only or Apply to All if you want to apply the 

change to the entire presentation. 

Dipl.-Ing. Mathias Dlugay 

Plattenwerkstoffe 

 
Plattenwerkstoffe für jeden Einsatzbereich:  
 
Für alle Herausforderungen für Wand, Decke, Raumsysteme oder Boden.  
 
Wohnbau, Holzbau oder die Konstruktion von Feuchträumen.  
 
Für Brandschutz, Schallschutz, Gestaltung,  Strahlenschutz oder Flächentemperierung.  
 

BAUSTOFF  



GEGENÜBERSTELLUNG DIN EN 520 UND DIN18180 

Gipsplattentypen nach DIN EN 520 Gipskartonplattentyp nach DIN 18180 

Gipsplatte Typ A Gipskarton-Bauplatte (GKB) 

Gipsplatte Typ H (1/2/3) mit reduzierter  Wasseraufnahme 

(Deutschland H2) 

Gipskarton-Bauplatte imprägniert (GKBI)  (optisches 

Merkmal: grüner Karton) 
GKFI 

Gipsplatte Typ F mit verbessertem  Gefügezusammenhalt des 

Kerns  bei hohen Temperaturen 

Gipskarton-Feuerschutzplatte (GKF) 

Gipsplatte Typ D mit definierter Dichte herstellerspezifische Entsprechungen 

Gipsplatte Typ R mit erhöhter Festigkeit 

Gipsplatte Typ I mit erhöhter  Oberflächenhärte 

Putzträgerplatte Typ P Gipskarton- Putzträgerplatte (GKP) 

Gipsplatte für Beplankungen Typ E 

mit reduzierter Wasseraufnahmefähigkeit  und minimierter 

Wasserdampfdurchlässigkeit 

Keine nationale Entsprechung in  Deutschland 



PLATTENSTÄRKEN UND EINSATZBEREICHE 

Für den gesamten  

Innenausbau  

 

12,5 mm 

Einsatz als Formplatte  

für gebogene Bauteile 
6,0 mm 

9,5 mm 

Als Trockenputz (Wand) oder  
Lastverteilerplatte (Boden)  

auf Trockenschüttung 

Als Beplankungsmaterial z.B. für 

Brandschutzkonstruktionen 
15 - 25 mm 



Gips(karton)platten 

 

 Gipsbrei mit Zusatzmittel (je nach Plattentyp) wird auf     

 Karton aufgebracht 

Der Gipsplattenstrang wird auf Bandstraßen 

 geschnitten, getrocknet und  beschriftet 

Die verschiedenen Kanten werden vor der  Trocknung  

 durch Schienen gebildet 

Gipsfaserplatten 
 
 Gipsfaserplatten besitzen keine Kartonummantelung 

Gips wird mit Zellulosefasern vermengt und gepresst 
 
Kanten entstehen bei der Pressung, durch versetztes 

 aufeinander kleben zweier Platten - oder durch Fräsen
   

UNTERSCHIEDE DER PLATTENARTEN 

GIPSPLATTEN - GIPSFASERPLATTEN 

BAUSTOFFE 



WICHTIGE NORMEN FÜR DEN LEISTUNGSBEREICH TROCKENBAU 

• DIN 18180   Gipskartonplatten; Anforderungen, Arten, Prüfungen 

• DIN 18181   Gipskartonplatten im Hochbau; Grundlagen für die Verarbeitung              

• DIN 18182   Zubehör für die Verarbeitung von Gipskartonplatten 

• DIN 18183   Montagewände aus Gipskartonplatten     

 
• DIN 18168   Leichte Deckenbekleidungen und Unterdecken 

• DIN 18202   Toleranzen im Hochbau 

• DIN   4102   Brandverhalten von Baustoffen und Bauteilen 

• DIN   4108   Wärmeschutz im Hochbau 

• DIN   4109   Schallschutz im Hochbau 

• DIN 18340   Trockenbauarbeiten             



1. Anwendungsbereich 

2. Normative Verweisungen 

3. Begriffe 

4. Lagerung, Transport und Einbau 

5. Allgemeines 

6. Verarbeitung ohne Unterkonstruktion 

7. Verspachtelung der Fugen 

8. Bewegungsfugen-/ Dehnfugen 

9. Verarbeitung von Gips-Putzträgerplatten 

10.Verarbeitung von Gipsplatten in  Räumen mit höheren Feuchte 

DIN 18181 Grundlagen der Verarbeitung 



GRUNDLAGEN FÜR DIE VERARBEITUNG   DIN 18181 



AUFGABEN UND FUNKTIONEN 

TROCKENBAU WÄNDE 

Architektonisch 

Grundrissbildung 

Raumtrennung 

Absturzsicherung 

Raumgestaltung 

Bauökologie 

Bauphysikalisch 

Schallschutz 

Raumakustik 

Brandschutz 

Wärme-Feuchteschutz 

Innenraumlufthygiene 

Gebäudetechnisch 

Führung von Leitungen/Unterbringung 
von  technischen Anlagen 

Klimatisierung 

Strahlenschutz 

Einbruchhemmung 

Sicherung von Reinraum-  

Anforderungen 



NICHTTRAGENDE INNERE TRENNWÄNDE 

BEGRIFF NACH DIN 4103 T. 1 

- Raumtrennwände mit Flächengewichten bis 1,5 kN/m2 

 

- Eigenlast darf  durch einen gleichmäßigen Zuschlag zur Deckennutzlast berücksichtigt werden 

 

- werden überwiegend durch Eigengewicht beansprucht und zu statischen Aufgaben im allgemeinen nicht  

  herangezogen 

  

- müssen Lasten aufnehmen und auf tragende Bauteile übertragen 

 

- übernehmen bauphysikalische Aufgaben  

   

TRENNWÄNDE IN STÄNDERBAUWEISE 



Allgemeine Anforderungen an leichte Trennwände 

Gebrauchstauglichkeit 

Raumabschluss 

Befestigung 

 

 

Biegetragfähigkeit 

Menschengedränge 

Windbelastungen 

 

 

Stoßbelastung 

weicher Stoß 

harter Stoß 

 

 

Konsollasten 

Befestigung an der Beplankung 

Befestigung am Ständerwerk 

Tragständer 

TRENNWÄNDE IN STÄNDERBAUWEISE 



Eine Unterkonstruktion aus z.B. Metallprofilen besteht senkrecht aus  

C-förmigen und waagerecht an Decke und Boden aus U-förmigen verzinkten Stahlblechprofilen 

in den Breiten 50, 75, 100 , 125 und 150 mm oder U-förmigen Aussteifungsprofilen  

: 

 

 CW Profile 0,6 mm         UW Profile 0,6 mm              UA Profile 2 mm  

PROFIL-TECHNIK TROCKENBAU 



CW UW 

EINFACH- UND DOPPELSTÄNDERWÄNDE NACH DIN 18183-1 

 



direkt befestigte Vorsatzschalen 
freistehende Vorsatzschalen 

WANDSYSTEME NACH DIN 18183-1: 

Nicht tragende innere Trennwände mit Gipsplatten und Metallunterkonstruktion  nach DIN 

18183-1 werden unterschieden in: 

Einfachständerwände                                               Doppelständerwände 



 

Vorsatzschalen direkt befestigt 

 

 
  

 

Freistehende Vorsatzschale 

FREISTEHENDE UND DIREKT BEFESTIGTE VORSATZSCHALEN 

MIT METALLUNTERKONSTRUKTION NACH DIN 18183-1 



FREISTEHENDE VORSATZSCHALEN NACH DIN 18183-1:  EINSATZBEREICHE 



 

Systemübersicht 

 

 

                   Einfachständerwand 

Doppelständerwand 

 

 

 

 

  

Ständerachsabstand 

 

 625    mm 

 417    mm 

 312,5 mm 

 

EINFACH- UND DOPPELSTÄNDERWÄNDE NACH DIN 18183-1 



EINFACHSTÄNDERWÄNDE NACH DIN 18183-1 

 

 

 

                    



System Profil nach  DIN 

18182, 

Teil 1 

Dicke der Beplankung  je 

Seite 

(mm) 

Wanddicke  

(mm) 

max. Wandhöhe,  

Einbaubereich 

(mm) 

I II 

CW 50/75 CW 50x50x06 

CW 50x50x07 

12,5 75 3000 2750 

2600 

CW 50/100 CW 50x50x06  CW 

50x50x07 

12,5 + 12,5 100 4000 3500 

2600 

CW 75/100 CW 75x50x06 12,5 100 4000 4000 

CW 75/125 CW 75x50x06  CW 

75x50x07 

12,5 + 12,5 125 5050 5000 

3750 

CW 100/125 CW 100x50x06 12,5 125 5000 4250 

CW 100/150 CW 100x50x06 12,5 + 12,5 150 6500 5750 

ZULÄSSIGE BAUHÖHEN FÜR EINFACHSTÄNDERWÄNDE  

NACH DIN 18183-1 

Herstellerspezifische Konstruktionen mit größere Höhen gemäß AbP. 

Im Brandschutz sind die Bauhöhen auf 5,00 m begrenzt, sofern nicht in einem AbP anders definiert. 



DOPPELSTÄNDERWÄNDE NACH DIN 18183-1 

 

 

 

                    



DOPPELSTÄNDERWÄNDE NACH DIN 18183-1 

 

 

 

                    



ARTEN DER SCHALLÜBERTRAGUNG 



DER HÖRBEREICH DES MENSCHEN 

Das Hörfeld des menschlichen Gehörs erstreckt sich von 16 Hz 

bis 20.000 Hz.  

 

Sehr tiefe und hohe Frequenzen sind erst mit höherer 

Lautstärke wahrnehmbar.  

 

Frequenzen zwischen 200 Hz und 8.000 Hz sind gut 

wahrnehmbar und für solche zwischen 2.000 Hz und 5.000 Hz 

ist das menschliche Ohr besonders empfindlich.  

 

Zwischen 2 kHz und 5 kHz ist das Ohr daher auch gegenüber 

Schädigung sehr empfindlich.  

 





GERÄUSCHE DES ALLTAGS 

Ruhiger Raum nachts, Blätterrauschen 

Ruhiger Raum tagsüber 

Normale Sprache 

Sehr laute Sprache 

Verkehrslärm an einer lauten Straße 

Fabrikhalle mit lauten Produktionsanlagen 

Flugzeug (Jet) 

10- 20  dB(A) 

25- 35  dB(A) 

50- 60  dB(A) 

70  dB(A) 

70- 90  dB(A) 

90- 100 dB(A) 

140 dB(A) 
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DIE NEUE DIN 4109:2016-07 

Die neue Fassung besteht aus neun Teilen: 

  

 DIN 4109-1:    Mindestanforderungen  

 DIN 4109-2:    Rechnerische Nachweise der Erfüllung der Anforderungen Daten für die rechnerischen Nachweise        

des Schallschutzes (Bauteilkatalog):  

 DIN 4109-31:  Rahmendokument  

 DIN 4109-32:  Massivbau  

 DIN 4109-33:  Holz-, Leicht- und Trockenbau  

 DIN 4109-34:  Vorsatzkonstruktionen vor massiven Bauteilen  

 DIN 4109-35:  Elemente, Fenster, Türen, Vorhangfassaden  

 DIN 4109-36:  Gebäudetechnische Anlagen  

 DIN 4109-4:    Bauakustische Prüfungen 

Die in Kapitel 3 des Beiblatts 2 zu DIN 4109:1989-11 aufgeführten „Vorschläge für einen erhöhten Schallschutz“ und 

die „Empfehlungen für den Schallschutz im eigenen Wohn- oder Arbeitsbereich“ sind bis auf Weiteres gültig! 



und Türen zum Schutz gegen Schallübertragung aus einem fremden Wohn- oder Arbeitsbereich 

ERFORDERLICHE LUFTSCHALLDÄMMUNG VON WÄNDEN 



DEFINITION DER SCHALLSCHUTZSTUFEN NACH VDI 4100 

 Wohnqualität     Wohnungstyp  
SSt I  Absenkung der Belästigung auf ein zumutbares Maß   Standard  

SSt II  Bewohner finden im Allgemeinen Ruhe    Komfortansprüche  

SSt III  Bewohner finden ein hohes Maß an Ruhe   Besonders hohe Komfortansprüche 



 

 

 

 

 

 

 

 

 

 

 

 

SCHALLSCHUTZ DEGA – EMPFEHLUNG 103 

 

BESCHREIBUNG DER SUBJEKTIVEN WAHRNEHMBARKEIT ÜBLICHER 

WOHNGERÄUSCHE ZWISCHEN WOHNEINHEITEN GEMÄß DEGA 

*Von der DEGA definierte Anforderungen R’w an das bewertete Schalldämm-Maß von Wänden im eingebauten Zustand (inkl. Nebenwege). 



 

 

Die Anforderungen nach DIN 4109 gelten für den Schallschutz zwischen Räumen unter Einbezug aller an der 

Schallübertragung beteiligten Bauteile und Nebenwege und nicht für die Schalldämmung der trennenden Bauteile allein. 

BAUPHYSIKALISCHE GRUNDBEGRIFFE 

ANFORDERUNGEN NACH DIN 4109 

Die Berechnung der Schalldämmung erfolgt auf Grundlage der in DIN 4109-2:2016-07 dargestellten Rechenverfahren mit 

den in den Teilen 32, 33, 34 und 35 aufgeführten Bauteildaten.  

 

Basis ist das europäische Rechenmodell der DIN EN 12354, welches nun in die deutsche Schallschutznorm DIN 4109:2016 

eingearbeitet wurde.  

 



 

 

BAUPHYSIKALISCHE GRUNDBEGRIFFE 

Flankierende Bauteile 

 

Die einzelnen Schallübertragungswege (insbesondere über die flankierenden Bauteile) werden darin genauer erfasst als im bisherigen Verfahren 

Flankierende Bauteile  

Bauteile, die zusätzlich zu dem raumtrennenden Element an der Schallübertragung beteiligt sind und die im 

Allgemeinen senkrecht zum Trennelement stehen, z. B. Decke, Fußboden, linke und rechte Seitenwand 

Flankenübertragung  

Die Flankenübertragung ist Teil der Nebenwegübertragung, die ausschließlich über die angrenzenden 

flankierenden Bauteile erfolgt, d. h. unter Ausschluss der Übertragung durch Undichtheiten, Raumluftanlagen, 

Leitungen und Ähnliches. 



3

9  

DIE ALTE DIN 4109 

Übertragungswege DIN 4109:1989 

 Trennbauteil:  

Schalldämm-Maß (Rechenwert) Rw,R 

 

 

Flankierende Bauteile: 

(Flankenwege zusammengefasst) 

Massivbauverfahren: 

Korrekturwerte (m‘ mittel)  

KL,1 und KL,2 

bzw. 

Leichtbauverfahren: 

Schalllängsdämm-Maße R‘L,w,R 

 

 

Ergebnis: 

Bauschalldämm-Maß R‘w,R 

 

R‘L,w,R 
Rw,R 



 

 

Bauphysikalische Grundbegriffe 

Anforderungen nach DIN 4109-2:2016-07  

Im realen Fall wird nicht nur über das trennende Bauteil Schallenergie übertragen, 

flankierende Bauteile können ebenso dazu beitragen. 



Die Berechnung des vorhandenen Luftschalldämm-Maßes erfolgt nach DIN 4109:2016 (vereinfachtes Verfahren nach DIN EN 

ISO 12354) durch die energetische Addition aller möglichen Transmissionswege.  

 

Mögliche Übertragungswege sind: 

 

 Direkte Schallübertragung über das trennende Bauteil, Weg:  

 Direkt – Direkt (Dd), beschrieben durch das bewertete Luftschalldämm-Maß, ermittelt ohne Flankenübertragung 

 Übertragung über Flanke 1,Wege Flanke – Flanke (Ff), Flanke – Direkt (Fd) sowie Direkt – Flanke (Df) 

 Übertragung über Flanke 2, Wege Ff, Fd, Df 

 Übertragung über Flanke 3, Wege Ff, Fd, Df 

 Übertragung über Flanke 4, Wege Ff, Fd, Df 

 

Insgesamt sind also die luftschalldämmenden Eigenschaften von 13 Übertragungswegen: Ein direkter sowie jeweils drei 

über die vorhandenen Flanken, zu ermitteln.  

 

Das resultierende Luftschalldämm-Maß R’w des zu prüfenden Bauteils errechnet sich dann durch die energetische Addition 

der einzelnen Beiträge. 

NACHWEIS NACH DIN 4109:2016 

Zusammenstellung der möglichen Schallübertragungswege nach DIN 4109-2:2016 



SCHALLSCHUTZBERECHNUNG NACH DIN 4109-2:2016-07 

Das resultierende Luftschalldämm-Maß R‘w errechnet sich dann durch die energetische 

Addition der einzelnen Beiträge: 

 

Ff 

Df 
Fd 

Dd 

R´ 𝑤 = −10 log 10
−𝑅𝐷𝑑,𝑤

10  +   10
−𝑅𝐹𝑓,𝑤

10
 

4

𝐹=𝑓=1

+ 10
−𝑅𝐷𝑓,𝑤

10
 

4

𝑓=1

+ 10
−𝑅𝐹𝑑,𝑤

10
 

4

𝐹=1
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ENTKOPPLUNG DER SCHALEN  

DURCH DOPPELSTÄNDER 

Entkopplung Doppelständer
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90

50 80 12
5

20
0

31
5

50
0

80
0

1.
25

0

2.
00

0

3.
15

0
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Frequenz in Hz

S
ch
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ld

äm
m

-M
aß

 R
 in

 d
B

CW 100/150-80

CW 50+50/155-2x40

CW 100+100/255-2x80

SP 100+100/255-2x80

Rw,R = 53 dB 

Rw,R = 60 dB 

Rw,R = 63 dB 

Rw,R = 69 dB 



Rw, R Rw, R Verbesserung 

1-lagig 45 dB 2-lagig 53 dB 
+8 dB 

ohne 

Dämmung 

41 dB mit 

Dämmung 

50 dB 
+9 dB 

40 mm 

Dämmung 

51 dB 80 mm 

Dämmung 

53 dB 
+2 dB 

Holz- 

Ständer 

42 dB Metall- 

Ständer 

50 dB 
+8 dB 

Bauplatte 

GKB 

53 dB Schallschutz 

Platte 

57 dB 
+4 dB 

Massiv 

1-schalig 

335 kg/m² 

50 dB Leicht 

2-schalig 

45 kg/m² 

53 dB 

+3 dB 

ZUSAMMENFASSUNG 
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AUSSCHREIBUNG- SYSTEMSUCHE 

www.rigips.de 



AUSSCHREIBUNG- SYSTEMSUCHE 

www.rigips.de 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



KONSTRUKTION 
Schallschutz 



DETAILAUSBILDUNG  

Was leisten die Flanken? 

 



AUFGABEN UND FUNKTIONEN VON DECKENKONSTRUKTIONEN 

Architektonisch 

 Oberer Raumabschluss 

 Strukturierung des  

Deckenbereichs 

 Design und Gestaltung 

 ästhetische Integration  von 

Funktionen (z.B.  Licht, 

Befestigung) 

 Rekonstruktion 

Bauphysikalisch 

 Verbesserung des  

Luftschallschutzes 

 Verbesserung des  

Trittschallschutzes 

 Regelung der Raumakustik 

 Brandschutz 

 Wärmeschutz 

 Innenraumlufthygiene 

Gebäudetechnisch 

 Führung von Leitungen/  

Unterbringung von 

technischen Anlagen mit  der 

Möglichkeit von  Wartung und 

Austausch 

 Klimatisierung 

 Strahlenschutz 



LEICHTE UNTERDECKEN UND DECKENBEKLEIDUNGEN 

Leichte Unterdecken und Deckenbekleidungen sind in der  

DIN 18168 zusammengefasst. 

 

Dies sind Decken, die einschließlich Einbauten eine Eigenlast von maximal 50 Kg/ m2 aufweisen. Sie 

besitzen keine wesentliche Tragfähigkeit und sind an tragenden Bauteilen befestigt. 

 

Sie dürfen nicht betreten werden. 

 

Die Norm enthält Angaben zur Standsicherheit, Anforderungen für die bauliche Durchbildung der tragenden 

Teile der leichten Deckenbekleidungen und Unterdecken und deren Befestigung an tragenden Bauteilen. 



Übung  Rasterdecken, Einlegesysteme 

   Fugenlose Deckensysteme 

    

   

DECKENSYSTEME 

Rasterdecken, Einlegesysteme 

Fugenlose Deckensysteme  



DECKENSYSTEME 

Rasterdecken, Einlegesysteme 

Fugenlose Deckensysteme  

Einlegemontage Schraubmontage auf UK  



UNTERDECKEN UND DECKENBEKLEIDUNGEN 

Materialien für die Decklage 

Die Vielfalt der Gestaltungsmöglichkeiten im Deckenbereich ist enorm. 

Gips ist hier ein Hauptwerkstoff für Deckenkonstruktionen mit 

 

 Gipsplatten 

 Gipsvliesplatten 

 Gipslochplatten 

 Gipsfaserplatten 

 werkseitig beschichteten Gips- oder Gipsfaserplatten 

 vorgefertigte Deckenelemente aus Gips 

 

Aber auch andere Werkstoffe spielen in der Deckengestaltung eine bedeutende Rolle, wie 

 

 Mineralplatten 

 metallische Werkstoffe 

 Nichtmetalle wie Aluminium 

 textile und Folien-Werkstoffe 

 HPL-Platten 

 Holzwerkstoffe 

 Rippenstreckmetalle und Gipsputze, für moderne Decken in Rabitztechnik  oder zur 

Nachbildung historischer Decken 



 Direkt befestigte Decken (Deckenbekleidung) 

 Abgehängte Deckensysteme (Unterdecke) 

 Freitragende Decken 

DECKENSYSTEME 



DECKENSYSTEME 

 Direkt befestigte Decken (Deckenbekleidung) 

 Abgehängte Deckensysteme (Unterdecke) 

 Freitragende Decken 



DECKENKOMPONENTEN 

Leichte Deckenbekleidungen und Unterdecken bestehen aus folgenden Komponenten: 
 

Verankerungselemente 
Abhänger 
Unterkonstruktion (UK) 
Decklagen 
Verbindungsmittel 



Prinzipien Lochdecke  

Nonius-System Unterteil CD 250 

mit Kreuzschnellverbinder 

Nonius-System Unterteil CD 400 

mit Kreuzschnellverbinder 

Deckenprofil CD 60/27 mit 

U-Direktabhanger 

Deckenprofil CD 60/27 mit 

justierbarem Direktabhanger 

Deckenprofil CD 60/27 mit 

Direktbefestiger 



LASTEINFLUSSFLÄCHE EINES ABHÄNGERS: WAHL DER 

LASTKLASSE 

Die DIN EN 13964 ermittelt eine spezifische zulässige Belastung für jede  Abhängerprodukt. 

 

DIN 18168-2 unterscheidet bei Anhängern nach drei Lastklassen. 

Dieses Vorgehen hat sich bewährt und wir in der Praxis weiter angewendet.  Abhänger und Verbindungselemente 

werden laut DIN18168-2 in folgende Lastklassen  eingeteilt: 

 

 Klasse 1: zul. F = 0,15 kN 

 Klasse 2: zul. F = 0,25 kN 

 Klasse 3: zul. F = 0,40 kN 

Für abgehängte Unterdecken und Deckenbekleidungen ist zulässig:  maximale Eigenlast 

einschließlich Einbauten von 0,5 kN/m². 

 

Dies ist auch bei der Anordnung verschiedener Unterdecken untereinander und bei der  Verlegung von 

Installationen im Deckenhohlraum zu beachten. 

 

Weitere Lasten sind an der Rohdecke oder Weitspannträgern zu befestigen. 



PROFILABSTÄNDE DER UNTERKONSTRUKTION 

und Stützweiten nach Din 18181 

Der richtige Aufbau des Deckenrasters ist wesentlich  für die 

Statik einer abgehängten Decke. 

Daher ist das korrekte Verständnis der Normangaben  

entscheidend: 

(1) Der Abstand bzw. das Achsmaß der Tragprofile  

entspricht  der „Spannweite der Platten“ 

(2) Der Abstand bzw. das Achsmaß der Grundprofile  

entspricht der „Stützweite der Tragprofile“ 

(3)  Abstand der Abhänger 

 

 

 

 

 

 

(1) Abstand der Tragprofile (Plattenprofile) 

 

 

 

 

 

 

 

(2)   Abstand der Grundprofile 

Abstand der Abhänger (3) 



LASTEINFLUSSFLÄCHE EINES ABHÄNGERS  
WAHL DER LASTKLASSE 

Überschlägliche Ermittlung der  

Einflussfläche eines Abhängers: 

Einflussfläche AE= 

Abstand der Grundprofile  x Abstand der Abhänger 

Überschlägliche Ermittlung der Belastung eines  

Abhängers: 

 

vorh.F = (gBeplankung  + zul.p) x AE 
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Hängerabstand 



Freie Anschlüsse 

 

. 

RANDANSCHLÜSSE VON MONTAGEDECKEN 

Starre Anschlüsse 

 

 



LEICHTE UNTERDECKEN 

DETAILS  

2 x 20mm GKF F90 A  

Brandbelastung von unten 



Prinzipien der Schalltechnik  

Wege des Schalls 

Schall 

Schallreflexion Schallabsorption Schalltransmission 



Raumakustik 

Nachhallregulierung 

Schallabsorption 

DIN 18041 

Pegelsenkung  

Schallquelle und Zuhörer befinden sich  

im gleichen Raum (Schalldämpfung) 

Raumakustik Hörsamkeit 



Zeichnung  

Absorber 

     

Plattenwerkstoffe Poröse Baustoffe Stoff, Teppich, Wandbeläge Akustik Putz 

Mineralfaserplatten Holzfaserplatten Lochplatten Metallplatten 



Prinzipien der Schalltechnik 

Schallabsorption  

Schallabsorptionsgrad α 

 

Verhältnis der von einer Fläche nicht reflektierten Schallenergie zur 

einfallenden Schallenergie. 

Schallabsorptionsgrad α =  -------------------------------------------------- 
auftreffende Schallenergie 

nichtreflektierende Schallenergie 



Prinzipien der Schalltechnik  

 

Poröse Absorber 

Plattenabsorber Lochabsorber Poröse Absorber 

Resonanzabsorber 

Schallabsorber 

vorwiegend für niedrige 

Frequenzen 

vorwiegend für mittlere 

Frequenzen 

vorwiegend für hohe 

Frequenzen 



Prinzipien der Schalltechnik  

10/23 rund 

12/22/66  

8-15-20 

Streuloch 



DETAILS LOCHDECKE 

Bewegungsfugen des Rohbaus müssen in die Konstruktion der Unterdecken übernommen werden.  

Darüber hinaus sollen Dehnungsfugen grundsätzlich im Abstand  von etwa 10 m sowohl in Längs- als auch in Querrichtung angeordnet werden.  

Eine Reduzierung der genannten Seitenlangen ist erforderlich, wenn eine freie Verformung 

der Deckenflache behindert bzw. langestreckte Deckenmit relativ großen Einbauleuchten (z.B. Flurdecken) eingebaut  werden.  



Prinzipien der Schalltechnik  



Prinzipien der Schalltechnik  



Prinzipien der Schalltechnik  



Prinzipien der Schalltechnik  



DECKENSYSTEME 

 

Max 0,15 KN 



Künstler Evangelos Papadopoulos  

Künstler Evangelos Papadopoulos  

Akustikputzbeschichtungen 

Die Kombination: Akustikplatten mit bauseitiger Putzbeschichtung. 

 Ausgewählte -Akustikplatten sind die Grundlage für die bauseitige Putzbeschichtung, die in ihrer Kombination mit dem 

mineralischen Akustikputz über hervorragende akustische Eigenschaften verfügen.  

Plattendicke 12,5 mm 

Breite x Lange 1.250 x 2.000 mm 

Lochung Versetzte 

Rundlochung 

Lochflächenanteil 19,6 % 

Plattengewicht ca. 8,5 kg/m2 



Künstler Evangelos Papadopoulos  

Künstler Evangelos Papadopoulos  

Akustikputzbeschichtungen 



Prinzipien der Schalltechnik  

Schallabsorption 

Entzug von Schallenergie aus einem Raum oder Raumbereich 

 

Schallabsorptionsgrad a 

Verhältnis der von einer Fläche nicht reflektierten Schallenergie zur 

einfallenden Schallenergie. 

 

Schallabsorptionsgrad as 

Durch akustische Prüfung in einem Hallraum wird der 

Schallabsorptionsgrad eines Materials für diffusen Schalleinfall 

ermittelt. 

 

praktischer Schallabsorptionsgrad ap 

Schallabsorptionsgrad für Oktavbandbreite 

 

berwerteter Schallabsorptionsgrad aw 

Einzelangabe für das Schallabsorptionsvermögen eines Materials, die 

sich aus dem Vergleich der praktischen Schallabsorptionsgrade mit 

den Werten einer Bezugskurve ergibt. 

 





Um die Nachhallzeit zu berechnen, benötigt man Angaben zur Bestimmung des Raumvolumens und 

der Flächengrößen der Begrenzungsflächen ( z.B. Zeichnung ). 

Angaben zu den Schallabsorptionsgraden der verwendeten Materialien. Baustofftabellen oder........ 

Schallabsorptionsgradkurven der Hallraummessungen. 

Berechnung der Nachhallzeit für kleine und mittlere Räume 



Grundlage ist die Sabinesche Formel: 

T = 0,163 x V / A 
T = Nachhallzeit in Sekunden 

V = Raumvolumen in m3 

A = äquivalente Absorptionsfläche in m2  ( ά = 1 ) 

Berechnung der Nachhallzeit 





Anforderung an die Nachhallzeit nach Raumnutzungen 

DIN18041 “ Hörsamkeit in kleinen und mittelgroßen Räumen” 



Optimale Nachhallzeiten 

Kleine Sprachstudios:   ca. 0,4 Sek.  

Besprechungsräume:    ca. 0,8 bis 1,0 Sek. 

Klassische Musik:        ca. 1,5 Sek. 

Kirchen (Gesang u. Orgel): ca. 2,7 Sek. 



Optimale Nachhallzeiten 



Klassenraum, Schule, Unterricht 

 
Raumlänge:   10 m 

 

Raumbreite:   7m 

 

Raumhöhe:   3m 

 

Volumen:   210m³ 

 

 















Prinzipien der Schalltechnik  

 

Eignung eines Raumes für bestimmte Schalldarbietungen, insbesondere 

angemessene sprachliche Kommunikation und musikalische Darbietungen. 

 
Die Hörsamkeit eines Raumes wird vorwiegend bestimmt durch:   

 

  Die geometrische Form des Raumes 

 

  Die Auswahl und Verteilung schallabsorbierender und  schallreflektierender Flächen 

 

  Die Nachhallzeit und den Gesamtstörschalldruckpegel  

 



Prinzipien der Schalltechnik 

Raumgeometrie  



Die Schallversorgung 

1. Direktschall, d.h. der direkte Weg von der Schallquelle zum Zuhörer. Er ist der Hauptvermittler des 

Schallereignisses und ausschlaggebend für die Hörqualität 

2. Reflexionsschall, er entsteht durch Reflexionen an den Raumbegrenzungsflächen und Einbauten. 



Decke – reflektierender Bereich Decke – absorbierender Bereich 

Wandabsorber 

Reflexionen 

1. Direktschall 

2. Reflexionsschall 



Reflexionen 

1. Direktschall 

2. Reflexionsschall 

Laufwegdifferenz    =  < 17 m 

Laufzeitunterschied  < 50 ms (0,05s) 

R – D = 7m – 5m = 2,0 m < 17 m 

Deutlichkeitserhöhend 

3 m 

5 m 

4 m 



Reflexionen 

1. Direktschall 

2. Reflexionsschall 

Laufwegdifferenz    =   > 17  

Laufzeitunterschied > 50 ms (0,05s) 

Echo E Laufwegdifferenz => 34 m (>100 ms) 

R – D = 24,5m – 3,5m = 21,0 > m 17 m 

Echo         E - D = 43,5 – 3,5 = 40 m > 34 m 

3,5m 

12,5m 

12 m 

Deutlichkeitsmindernd 

20 m 

20 m 

3,5m 



Reflexionen 

1. Direktschall 

2. Reflexionsschall 

Deutlichkeitsmindernd 

Querliegende Unterzüge 

Nichtübereinstimmung Hörrichtung und 

Akustikrichtung 



Reflexionen 

1. Direktschall 

2. Reflexionsschall 

Deutlichkeitsmindernd 

10 m 

Flatterecho 

Laufzeitunterschied > 50 ms 

Laufzeitunterschied:  20m • 340 m/s = 70 ms > 50 ms  



Prinzipien der Schalltechnik 



Prinzipien der Schalltechnik 



1. Direktschall 

2. Reflexionsschall 

Die Schallversorgung 



Die Schallversorgung 

Q 

Q` 

Q 
Q 

Ebene Fläche Ebene Konvexe Konkave Fläche 




